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File
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118
128
138
148
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198
288

REM ===== CIRCLE
A:

INPUT "“RADIUS %'
LET Perimeter =
LET Area = FI =
GOSUB Equals
PRINT
GOSUB Eguals
PRINT "Radius';R
GO5UB Dashes
PRINT "Perimeter

CI

;Radius

Radius = 2 = |
Radius™2
RCLE M

adius

218 PRINT USING "#._##",U13;Perimeter

228 GOSUB Dashes
238 PRINT "Area

258 GOSUB Equals
268 PRINT

278 SET FIX FALSE
288 CLS

298 STOP

318 E:
328 GOSUB Equals
338 PRIHT ™

340 GOSUB Dashes
358 PRIHNHT ™

BaxEdit is an editor for programs in Basic usable by Bax58C compiler.

1 - MW

240 PRINT USING '#._##",U02%;Area

388 REM ===== UHIT CHOICE =====

UHIT CHOICE "

£

m
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Basic language

Since the origin of the Basic language, Darmouth College in October 1964, many versions have emerged.
Every interactive computer system has had its version, from the most powerful mainframe to “pocket computers" ...

When it comes to PCs, whether under Windows, Linux or other OS, the variants are plethora of. (QuickBasic, QBasic,
Bywater Basic, True Basic, PowerBasic, Turbo Basic, wxBasic, Liberty Basic, SmallBasic, FreeBasic...)

The most widespread, Qbasic, QB45 and QB64 versions, inspired the Basic that can be used with the Bax58C compiler.
Not all features of Qbasic were implemented and variations had to be introduced to adapt to the target language.

Each line in the Basic program begins with a line number followed by at least one space and then a label or a statement.
A statement may contain :

* text <text>,

* variable names <variable>,

* numeric or alphanumeric values <value>,

* assignment expressions <expressions,

¢ conditional expressions <condition>,

e branch addresses: line numbers or labels <line> ou <label>.
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The Menus

7 BaxEdit
File | Edit Options 7

Mew Ctrl+M
Cpen... Ctrl+ 0O
Save... Ctrl+5
Print... Ctrl+P
Quit

£} BaxEdit

FicFile [ Edit| Options ?

Cut

Copy
Paste

Select all

Find...
Mext

Replace..,

Ctrl+ 4

Ctrl+F
F3

Ctrl+H

| §5) BaxEdit

File Edit [Options| ?

Font...

Colors...

Language...

| §5) BaxEdit

File Edit Options [7]

| About..

The “File" menu allows you to create a new Basic
file, open an existing one, save, print ...

The "Edit" menu is used to manage Cut / Copy /
Paste as well as text search and replacement.

The "Options" menu allows you to modify the text
font, the syntax highlighting of the Basic program
and to change the language.

The "?" menu allows to display the "About” screen.
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An icon bar can be added via the special menu displayable via the combination of keys SHIFT+ALT+F1

[

¥ | Button bar

Compiler button
Emulator button

File Explorer
v to the Left

to the Right

Special parameters...

File | Edit Opti

Mew
Open...

= Save...

Print...

die

[ Edit | Options 7

%

/ Select all
Find...
/ Mext

Replace..,

Cut

Copy
Paste

the compilation of the .bas program
opened in BaxEdit can be started

Basic help

if the .t58 program corresponding to
the .bas program exists, it can be
opened in the TI58C emulator for
testing.
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New

£ BaxEdit

EF’E Edit Options 7

to enter a new Basic program. Mew

Open...
Save..,

Print...

Quit

Ctrl+M
Ctrl+0
Ctrl+5%

Ctrl+P

Each line of the Basic program starts with a line number but this
number can be generated automatically when typing the first

letter of the instruction.

#7 BaxEdit - ppffram bas

=

File Edjp Options 7

188 r

ﬂ BaxEdit - program.bas

= | Bl

File Edit Options 7

188 rem

ﬁ BaxEdit - pregram.bas

= B

File Edit Options 7

188 REM ===== Hew program =====

As soon as the instruction is recognized it is
capitalized and the syntax coloring is applied.
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For entering a program, help is available for the instructions that can be used.

At the beginning of the line type the character ?

#7 BaxEdit

r

File Edit

Dpﬁmﬁ s

5 B [

File Edit Options ?

HEICIEE:

L2

i

!

188 ?

CALL
CHAIN
CLS
CLEAR
DI
DO
EMD
FOR
GOSUB
GOTO
IF
INKEY
INKEY%
INPUT
LET
LOOP
MEXT
ON
PRINT
REM
RETURN
SET
SLEEP
SOUNMD
SwaAP
UNTIL
WHILE

—

The list of Basic instructions that can be used is displayed.
Click on the instruction to add.

7 BaxEdit T .

File Edit Options 7

BEIE

S (¥]D|E] 1P

188 RE
181 7

This process can be repeated at the start of each line.
(in column 1 before numbering)

INKEY'$
INPUT
LET
LOapP
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Help is also available to find out the syntax of the instructions used.

= | B S

You must select the instruction then click on the "Basic help" button (or type the character ?) _>

Help [j

Basic Help

Select first a Ba=zic Kevword. . .

E’ BaxEdit - program.bas

File Edit Options

Help Eﬂ

DIM - definition of variables.
Syntax :
DIH <wariabler [ . <wariabler [ . <wariable:r ] ...]

<wariable: can be
— a numneric wvariable: alphanumeric nane
— an alphanumeric wariable: alphanumeric name ending in %
— a flag : alphanumeric name ending with % (10 max)
— an arrav: alphanumeric name followed by ({valus:)

Alphanumeric wariable:
if declared by DIM (Ex: DIM Var$) a wariable take=z 4 regis=ters
(20 alphanumeric characters)
if not declared a wariable take=s only one register
(5 alphanumeric characters)
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Open 7 BaxEdit

File | Edit Options ?

The "Open ..." function can only open files with the .bas Mew Ctrl+M
extension Ctr+0

Ctrl+%

Print... Ctrl+P

-'Ri_a ). e

L m_

Crate madified

Twpe

4 03 _caloubstion

| M_mansgement |
N 05 _mise

L D6 _dave_ramey

L. 07 BaSEC

L BOUPPX -

-~ |Bawo Cbaaj -

[ oen | [ Comce |

File game:

7 BaxEdit - circleEN bas = | {5
File Edit Options 7

[i#8 REM ===== CIRELE =====

118 A:

128 INPUT "RADIUS 7' ;Radius

138 LET Perimeter = Radius = 2 = P
148 LET Area = PI = Radius™?2

158 GOSUB Equals

168 PRIHT ™ CIRCLE "
178 GOSUB Equals

188 PRIHT "Radius" ;Radius

198 GOSUB Dashes

288 PRINT "Perimeter 2
2498 PRINT USIMG "H#.#H#",U1%;Perimeter B
228 GOSUB Dashes

238 PRINT "Area i

250 PRINT USIMG "H#.H##",U2%:Area

258 GOSUB Equals

268 PRIHNT

278 SET FIX FALSE

288 CLS

208 STOP

388 REM ===== UHIT CHOICE =====

318 E:

328 GOSUB Equals

338 PRIHT ™ UHMIT GHOICE "

348 GOSUB Dashes

358 PRIHNHT ™ 1 - HH " - |

£

m
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| #) BaxEdit - CERCLEBAS

= =

File Edit Options * 7

2540 PRINT USING "#.3#",U2% ;Surface
2508 GO3UB Egals

268 PRINT
278 3ET FIX
2ED CLS

298 3T0P

FALSE

Jaa
318
328
338
348

E:

GOSUB
PRINT
GOSUB Tirets
PRINT " 1 - MH

m

When inserting a new line, the line number is

7 BaxEdit - CERCLEBAS

File Edit Options 7

240 PRINT USING "#.4##",U2%;Surfa
258 GO3UB Egals

268 PRINT
278 3ET FIX
280 CLS
298 sTO0P
291 ¢
J88 E:
318 GOsue
328
338
348

FALSE

Egals
PRINT *

CHOIX UHNITE 73
GOSUB Tirets
PRINT " 1 - MH =H

m

generated automatically as soon as the first let-
ter of the instruction is typed.

7 BaxEdit - CERCLEBAS

= =

File Edit Options 7

240 PRINT USING "#.4##",U2% ;Surface

258 GO3UB Egals
268 PRINT

278 SET FIX FALSE
280 CLS

298 sT10P

291 REM

J88 E:

318 GOSUB Egals
328 PRINT * CHOIX UNITE
338 GOSUB Tirets
348 PRINT *

1 - HH

m

As soon as the instruction is recognized it is

7 BaxEdit - CERCLEBAS

= =

i capitalized and the syntax coloring is applied.

File Edit Options 7

240 PRINT USING "#.4##",U2% ;Surface

258 GO3UB Egals

268 PRINT

278 3ET FIX FALSE

280 CLS

298 sT0P

291 REM ===== CHOIX UHITE =====
J88 E:

318 GOSUB Egals

328 PRINT * CHOIX UNITE i
338 GOSUB Tirets

348

PRINT * 1 - HH %

m
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The numbering of the inserted lines is done
from 1 to 1. It is possible to renumber the
whole program by choosing the starting num-
ber and the numbering increment.

i 5’ BaxEdit - CERCLE.BAS

= | =

File Edit Options 7
258
258

268
278 SET H
280 CLS

298 sT0P
291 REM SH
J68 E:

Increment -

Numbering
Start number -

328 PRIN

310 GOSUH )
Yalidate

X ol 2

Cancel

338 GOSUBL
348 PRINT *

2 = e f 4

Right click
on the text shows
the numbering screen

\LLI

) BaxEdit - CERCLEBAS

| =]

File Edit Options

£

258 PRINT USIHG
258 GO3SUB Egals
268 PRINT

280 CLS
2908 STOP

318 E:
328 GOSUB Egals
338 PRINT ™

358 PRINT * 1

HoHH" U025 ;Surface

278 SET FIX FALSE

3808 REM ===== CHOIX UMWITE =====

CHOIX UNITE 2

3408 GOSUB Tirets

= MM (1]

m
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Save

programs can be saved with the .bas extension

B BaxEdit
File | Edit Options ?
Mew Ctri+M
Cpen... Ctrl+ 0
Ctrl+%
Ctrl+P
@Qv| 1 % ProgramData » TIEC » v|¢1~| Search L |
File name: -
Save as type: [Text Files v]
* Browse Folders [ Save ] [ Cancel ]
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Print

allows printing of the Basic program

| §2) BaxEdit
File | Edit Options ?
Mew Cri+M

Cpen... Ctrl+ 0O
Ctrl+5

Ctri+P

Print

General

Select Printer
% Add Printer

=i Fax
== Microsoft XP5 Document Writer

=5 PDF

Status: Ready

Location:

Comment:

Fage Range

®A Mumber of copies: 1 |
SE!EE'tiI.—'!'I I:!__in-enr Page

Faoes: || Cof
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100
110
120
130
140
150
160
170
180
190
200
210
220
230
240
250
260
270
280
290
300
310
320
330
340
350
360
EX ]
380
380
400
410
420
420
440
450
460
470
480
450
500
510
520
5310

BEM === Happy Numbgr ==

A

INPUT "Haxi ?";M

INPUT "Hombre ?";HN

GOSUB Egal

PRINT "Maxi™;M

PRINT "Nbre"; H

GOSUB Tirets

LET R = N

Encore:

LET 5 = 0

WHILE N <> 0
LET N
LET X
LET X
LET &
LET N

LOOR

LET 8 = INT(S + D.5)

IF § = B9 THEN Sulwant

IF & = 1 THEN Happy

LET N = §

GOTO Encore

REM Suiwvant

Sulvant:

LET R = R + 1

LET N = R

IF ¥ > M THEN Fin

GOTO Encora

REM Happy

Happy:

ERINT "HAPPY"; R

GOTO Sulvant

Fin:

GOSUB Egal

PRINT

STOP

Tirets:

PRINT * ——

RETURN

Egal :

PRINT " L]

RETURN

EMIL¥

L B B B e )

Bax58C Compiler

®

happynumFR.bas

Page 1
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Quit

close the program.

| §2) BaxEdit
File | Edit Options ?
Mew Ctri+MN
Open... Ctrl+ 0
Save... Ctrl+5
Print... Ctrl+P
( Quit )
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Cut / Copy / Paste

The editor allows the use of standard functions for Cut, Copy and Paste text.

' #) BaxEdit
FicFile [Edit| Options 7

Cut

Copy

Paste

Select all Ctrl+4
Find... Ctrl+F
Mext F3
Replace... Ctrl+H

The usual keyboard shortcuts are usable :
e CTRL X, CTRL C, CTRL V for cut / copy / paste
e CTRLF,CTRLH,F3 for find, replace, next
e CTRLA for select all
and also
e CTRLZ for cancel
e CTRLN,CTRLO, CTRL S for new, open, save
e CTRLP for print
e ALTF4 for quit
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Find

#7 BaxEdit

FicFile | Edit | Options ?

Cut

Copy
Paste

Select all

Chrl+A

Ctrl+F
F3

Ctri+H

# BaxEdit - happynumEN.bas = @] % |
File: Edit Options 7

188 REM ===== Happy Humbep ===== -
118 A: F
128 IHPUT "'Maxi ?"';H

138 IMPUT "Humber 7;H

148 GOSUB Equal

156 G

168 PRINT | Fnd-

176 GOSUB

188 LET R Enter the text to zearch:

128 Againi| |PRINT

288 LET S

218 WHILE @

228 LE

2306 L

248 L

258 LET 5 = § + ¥

2608 LET H = IHT{H)

270 LOOP =

For the search simply enter the text to search for.
Then use the F3 function key to search for the next ones.
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Replace

| #) Baxedit

FicFile | Edit | Options 7

Cut

Copy

Paste

Select all Ctrl+A

Find... Ctrl+F

Mext F3
E’ BaxEdit - happynumEN.bas |l=|E| 5= |
File. Edit Options 7
188 REM ===== Happy Humbef] ===== =
118 A: For the replacement, enter the text to find then
128 INPUT “QERERLND 7";H P
138 INPUT "Number 7" ;N the replacement text.
148 GOSUB Equal v
158 PRIHI imun®':H
168 PRI Raplace...
178 GO
188 LE}| Text to find: !Hauimun
1908 Ag
288 LE Heplace by: !Ha:-:i
218 WH
228 r Compliance with upper / lower caze
238
248 a) v X
258 Replace all Cancel
268 |
2780 LOL —_ _

If "Replace all” no confirmation is requested and each occurrence is replaced.
If “Verify" a confirmation is requested for each occurrence.

\

E} BaxEdit - happynumEM.bas

File

Edit

Options

?

\
)

188
118
128
138
148
1508
168
178
188
198
2808
218
228
230
240
250
268
278

P

WHILE

LET
LET
LET
LET
LET

LOOP

— o

1121 munfical
“Mumber 7";HN
Equal
"Maximun® ;M
"H# "; H
Daches

H

Happy Humber ==

»

m

H

Replace

2

BaxEdit

Yes Mo Cancel

N
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Font

27 BaxEdit

File Edit | Opticns | ?

Lanfuage...

Y

o

Font: Font style: Size:

[Eourer |Bald [1z | oK ]
Regular 10 A

e

() Curdz MT E 15
{} DaunPenh Bold [talic
) David
T DejaVu Sans
M DejaVu Sans Condens ™ i
~Sample
AaBbYvyZz
Script :
| Occidental |

To make it easier to read Basic programs in the editor, the use of a fixed
font (Courier, Fixedsys ...) is strongly recommended.
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Colors

In the BaxEdit editor, syntax highlighting is applicable to Basic programs to improve readability.

|27 BaxEdit

File Edit [Options| 7

| ) BaxEdit - circleEN.bas

File

Edit Options 7

——

F

hes
118
128
130
148
158
168
178
188
198
286
218
220
230
248
250
268
278
288
290
280
310
320
330
340
350

A:
INPUT

—— | [:IH[:LE ——— [

“"RADIUS 7" ;Radius

LET Perimeter = Radius = 2 * P | <@u(5)
LET Area = PI * Radius™2

GOSUB
PRINT
GOSUB
FRINT
GOSUB
FRINT
FRINT
GOSUB
FRINT
PRINT
GOSUB
PRINT

Equals

% CIRCLE e
Equals

"Radius" ;Radius 4_@
Dashes
"Perimeter
USIHG "#.#4", U415 :Perimeter
Pashes
"Area
USING "i#.##",U02%;Area
Equals

SET FIX FALSE

CLS

Equals
i UNIT CHDICE "
Dashes
& 1 - HMH "

ik

Colars

S2

Text color :

=)

Line numbers color :

W

Instructions color :

®

Labels color :

S

Comments color :

©

Constants color :

eV

Yalidate

O
15
O
N =)
I =
N

X

Cancel
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Languages

In the BaxEdit editor it is possible to change the language.
As standard 2 files are provided: BaxEdtFR.lan (French) and BaxEdtEN.lan (English) but you can create your own
BaxEdtXX.lan language file by translating one of the existing files.

| §2) BaxEdit

File Edit | Options | ?
Font...
Colors...

(Language..)

r Y

;l_anguage...

|
EN =

|| LFR
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About

displays the version number.

| B2 BaxEdit
File Edit Options 7]

[_ QbuutD F1

| Version 2020.09.24

& o
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File Explorer

A "File Explorer" side panel can be displayed via the key combination SHIFT+ALT+P or with the special menu

(accessible via SHIFT+ALT+F1)

e — .

File Edit Options ?

%" Button bar
Compiler button
Emulator button

File Explorer
v to the Left
to the Right

Special pararmeters...

B ET]1 B

3| (P

[ e [Windows] l—l

o A
%p,w,mnﬂ. File Explorer can be positioned :
(3TISEC * 1o the Left (SHIFT+ALT+L)
A Basic
i Bax58C or
= Fibonacci * to the Right (SHIFT+ALT+R)
v Button bar
Compiler button
Emulstor button
m:ﬁlu v File Explorer
DA%
‘
to the Right
Special parameters...
| S c: Windows] ~|
CA
‘3 ProgramData
iy TIS8C
‘_ABasic
i Bax58C
v Button bar
Compiler button
Emulator button
Fil fiboEN.ba
Vil | Fe=Explones fi‘mFFI_ba:
to the Left
v
Special parameters...
© 2011 Pierre Houbert Page 23
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Special parameters SHIFT+ALT+I

The "Special parameters” screen can be displayed via the key combination SHIFT+ALT+l or with the special menu
(accessible via SHIFT+ALT+F1) o
| v Button bar

Compiler butten

Emulator button

File Explorer
v to the Left

PR, I o vetey I
IO tNE RIgL

Special parameters...

The first page of "Special parameters” allows you to define the path of external programs that can be called: the Bax58C
compiler, the TI58C emulator and the Windows registry editor.

Special parameters |§|

Special parameters 172

Baxbsc Compiler :

|E:'xF'rcugram Filez\TISECAE AXBEC. exe zxs

TI58C Emulatar -
]E:'xF'rn:ngram FilezhTIRECATIREC exe e

Registry Editor :

||:: YWdindows R egedit. exe s
< >
) X
Yahdate Cancel
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The BaxEdit Editor configuration parameters can be stored
* either in a local BaxEdit.ini file (application directory),
¢ either in a BaxEdit.ini file in the Windows directory (systemroot),
* either in the Windows registry.

= Choosing local INI file deletes the BaxEdit.ini file from the Windows folder and creates the local file BaxEdit.ini,

= Choosing Windows INI file deletes the BaxEdit.ini file from the application folder and creates the Windows file
BaxEdit.ini,

= Choosing Register deletes the file BaxEdit.ini (local or Windows) and creates the settings in the registry.

Special parameters |§|

Special parameters 2/2

BaxEdit config in :

@ INI file [local] &7
" INI file [Windir]
" Register

{ ™,

N X

Yalidate Cancel

Click on the "Backup” button to save the parameters in
e aBaxEdityyyymmddhhmmess.ini file for general parameters
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Warning to the readers

The informations contained in this manual are given as an indicative guide and have no exhaustive character even certain.

As an example not restrictive, this manual can propose you one or several addresses of Web sites which will be not more current or
which the contents will have changed when you will access it.

So, this information should not engage the responsibility of the author of this manuel.

The author cannot be considered responsible for any omission, error or gap which would have been present into this manual as well as
consequences, whoever they are, who would result from information and indications supplied as well as with their use.

Products named in this manual are protected, and trademarks are registered by their holders of respective rights.

This manual is neither published, nor produced by the owners of the calculators which are concerned and the marks are used only as
name of products.
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